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FP4030MR Serial HMI

1. Introduction

The FP4030MR is a serial based keypad and LCD screen combination that is designed
info an IP65 rated bezel. It can connect to any of the 'Super' PLCs supplied by Triangle
Research International (TRi) via RS232 or RS485 and communicates via the native Hostlink
protocol as well as Modbus TCP if interfacing to 3rd party controllers.

This guide offers a walkthrough on how to get the FP4030MR HMI connected to a PC in
order fo transfer a HMI demo program to the unit, and also connect the HMI to a PLC in
order to run the program and demonstrate some basic control of a PLC from the HMI.

If at any time more information is required on HMI safety and protection ratings, HMI
Power, and HMI communication, please refer to the FP4030 Hardware or User Manual
provided at the following links:

hitp://www.triplc.com/documents/FP4030MR_Hardware.pdf
hitp://www.triplc.com/documents/FP4030MR_Reference.pdf

The following is only the minimum basic information required to get the FP4030MR set up
with TRI PLCs in most situations.
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Getting Connected at a Glance:

1. Connect the HMI to a PC by plugging the mini-USB end of the USB cable into the
FP4030MR and the standard USB end of the cable into one of your PCs USB ports.

2. Connect the HMI to the PLC by
a. Plugging the male end of the RS232/RS485 serial cable into the female DBY
connector on the FP4030MR.
b. Wiring the Tx+ (black wire) to the RS485+ terminal on the PLC and the Tx- (red
wire) to the RS485- terminal on the PLC.

3. Download and Install the Flexisoft for TRi PLCs Software

4, Connect 24V DC power to both the PLC and HMI.

5. Install the FP4030MR drivers to your PC from the C:\TRILOGI\FlexiSoft for TRi PLCs\USB
Drivers folder if not installed previously.

6. Open the “TRi PLC Demo.pzm” file from FlexiSoft using Project —> Open and select
the file from the C:\TRILOGI\FlexiSoft for TRi PLCs\Samples folder.

7. Transfer the demo program to the HMI using Project —> Transfer —> Download

8. Use TRILOGI to open the FP4030MR.PC6, which is also included in the “FP4030MR
Demos and Guides.zip” file, and transfer it to the PLC

For more detailed instructions, proceed to the subsequent sections of this guide.

2. Connect the HMIto a PC

Your FP4030MR requires a USB A-B cable (standard PC USB to Square USB) 1o connect the
HMI to your PC (not included), and a custom serial cable with RS232 and RS485
connectors to connect to your TRI PLC (included).

It should be connected per the below diagram:
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3. Connect FP4030MR to PLC

The included RS232 to RS485 (2 wire) cable connects between the HMI RS232 port (DB?
connector) and the PLC RS485 port (2 wire), as per the below diagram. Note that the
black wire is actually the RS485 + signal and the red wire is actually the RS485 - signal.

We recommend crimping plugs onto the red and black RS485 wires on the DB cable
supplied with the FPA030MR. This will ensure a proper connection when plugged into the
PLC RS485 screw terminal.
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The above drawing can also be referenced in case a custom cable is being built. Note
that pins 1 and 4 must be tied together and pins 8 and 9 must be tfied together on the
HMI COM port when constructing the RS485 cable connection.

4. Download and Install FlexiSoft for TRi PLCs HMI Software

You will have received an information sheet with the software download link, but the
download page can be accessed directly here:

http://www.tri-plc.com/FP4030MR/Flexisoft.zip

After downloading the software, do the following to complete the installation:
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1. Open the .zip file and extract the contents somewhere on your PC

Eile Edit Find Opticns Help

Open Extract Add Delete

-~

Eﬁ Flexisoft.zip Marne

4 | FlexiSoft-for-TriPLCs
, dotnetfx | dotnetft

159 FlexiSoft Setup.msi

@setup.exe

<
EE] Files 5, Folder: 2, Total Size: 193 MB

2. Run the “FlexiSoft SetUp.msi” file that is located in the “FlexiSoft-for-TriPLCs” folder
where you extracted the files.

3. Follow the steps to install the software. The FlexiPanels user manual should be
referenced for more information.

Once the software has installed you can start FlexiSoft from the start menu or desktop

Project  View Mode Tools Help
D'@UJQ"@ - Y O :{%@ At
D6 NEBE %
Drawing Tools ~ Quick Buttons ~ Show Data ~ Edit Data ~ Advanced Objects ~ Clock Objects -

Projects Information
Recent Projects

E¥=To i

[-{_1] Project List

FlexiSoft’

Figure 1: FlexiSoft Startup Screen
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5. Connect Power to HMI and PLC

The FP4030MR has 3 connections for power. +, -, and _4_ A 24VDC power supply should
e used, which can be the same supply used for the PLC.

Power should be connected to the FP4030MR as follows :
1. Connect the +24VDC terminal from the power supply to the + terminal on the
HMI.
2. Connect the OVDC (-) terminal from the power supply to the - terminal on the HMI.

3. The _4_ can generally be left unused, but the FlexiPanels user manual should be
referenced if you are unsure,

Power should be connected to the PLC as follows :
1. Connect the +24VDC terminal from the power supply to the +24V terminal on the
PLC.
2. Connect the OVDC (-) terminal from the power supply to the 0OV terminal on the
PLC.
3. Reference the PLC documentation for more information on this.

6. Install the FP4030 Device Drivers on the PC

The drivers may install automatically, but if not, then you can install the device manually
and select the CATRILOGI\FlexiSoft for TRi PLCs\USB Drivers folder to install from.

Open "Devices" or "Devices and Printers" from your PC control panel and open the
properties for the "Micro PLC" device.
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T @ <« All Contr... » Devices and Printers v O Search Devices and Printers y-l

Fle Edit View Tools Help )'s ERSVA=IE)

Add a device Add a printer Remove device = - 7]
4 Unspecified (3) A

—
5]

MicroPLC Prolific Silicon Labs
USB-to-Serial CP210x USE to
Comm Port UART Bridge
({COM3) (COM4)

MicroPLC  Model: MicroPLC
Categery:  Unknown

1 item selected il Computer

General | Hardware Driver | Details | Events

ﬂﬂ MicroPLC : HMI USE Device

=

Device Functions:

Driver Provider: REPL

Driver Date: 2010-04-07

Driver Version: 4010

Digital Signer: Renu Electronics Private Limited

To view details about the driver files.

To update the driver software for this device.

Mame Type
§ HMI USE Device Universal Se...

Device Function Summary
Manufacturer:  REPL
Location: Port_#0003. Hub_#0008

Device status: This device is working properly. Disables the selected device.

- If the device fails after updating the driver, roll
il back to the previously installed driver.

Uninstall To uninstall the driver (Advanced).

OK || Cancel

“ Select Properties -~ Select Update Driver
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e

Select the folder that contains drivers for your hardware.

How do you want to search for driver software?

> Egarch automatically for updated driver software . Images
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation Lamps
settings. '

. Monolamps

= Browse my computer for driver software b [ onoRectang ular

Locate and install driver software manually,

.. Rectangular

. Samples

4| | USB Drivers

32 WinkKP_WinVista
Cencel | L xBd_ WinKP_WinVista

= VCToolkit

Browse for driver files and include subfolders.
Folder: UISE Drivers

Select the USB Drivers folder and click

7. Load and Transfer HMI Sample Program

The sample program included with this quick start guide is called “TRi PLC Demo.pzm”.
You can open this file from FlexiSoft using Project — Open and selecting the file from the
CATRILOGI\FlexiSoft for TRi PLCs\Samples folder.

This sample program is already pre-configured for communication with a TRI PLC, and it is
possible to connect via RS485 or RS232 since both are shared on the HMI COM port and
there is N0 need to specify the specific interface.

Once you have opened the sample program, you can transfer it to the HMI as follows :
Go to the "Project” menu and select “Transfer->Download”.

A new window should appear as shown in Figure 2.

Make sure that USB mode is selected at the top-left of the window.

Make sure the Firmware box is checked.

Make sure that boxes under Project and Device Settings are all selected as shown
in Figure 2.

Click Download and wait for the message that the download has finished.
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[t v

Ready

Download to device ==
Mode Serial Settings
Serial

Download Options

Firmware [ Firmware download is necessary if new protocol on Network
Configuration is added or changed. )
Project
[¥] Application [ Data

[] Ladder [] Font

Device Settings
[#] Butomatically put unit in halt mode before download
[¥#] Automatically put unit in run mode after download

[ Initizlize keep memeary area after download

0%

Options << I I Download Abort

Figure 2: Download Window

NOTE:

The “Firmware” box typically
only needs to be checked
the first time a program s
being transferred 1o the HMI
or if any COM seftings have
changed or if there is a
fimware  update  being
installed to the HMI.

8. Load and Transfer PLC Sample Program

A Trilogi

PLC sample program, called FP4030MR.PC6,

is also included in the

"FP4030MRdoc.zip” file. This should be opened with Trilogi and transferred as normally
done with Trilogi (and TLServer for serial connections). You can find more information on
communicating with a PLC using Trilogi from the TL6 Programmers Reference Manudl.

The FP4030MR.PC6 sample program is only required for the Data Entry function included
in screen 11 of the “TRi PLC Demo.pzm” sample program. It could be modified to do
more if desired.
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9. Using the FP4030MR Sample Program

Now that the TRi PLC Demo.pzm sample program has been loaded in the HMI, you
should see the Home screen for this program :

FP4030MR [=| = @'

ﬂ Haome Screen ﬂ
Mext Screen

ﬂ Frewvious Screen ﬂ

j Home Screen

ﬂJJJJJM
150 T

Figure 3: Home Screen

You can fraverse through the different screens in the sample program by pressing F4 for
the next screen or F1 to go backward one page. You can also go back to the home
screen (above) by pressing F2. There are 12 screens total, but only screens 2-5 are shown
in Figures 4-7 below.

FP4D30MER ] & |- FP4030MR | | = |
A e o | e
= TREE - | = CREE -
Fa3 Fg F3 at FE
E N N [ S [T == e e =
5|?|a‘9 Os/- | |a|9|n|
Figure 4. I/O Screen Figure 5: Analog Screen
FP4030MR =l =[S FP4030MR =l = [
AN e s I e
Fz F5 Fz g g g F5
= URER = || 2 P =
L O N T I = N (I I N B
E | 7 | g | k| |I:|+.-'- [ | 7 | 2 | 3 ||:|+.-"-|
Figure 6: PWM Screen Figure 7: LCD Screen
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10. Start a New Program and Configure for a TRI PLC

When you start a new program you will be asked to select your HMI model and screen
orientation. You should select the FP4030MR (128 x 64) model as per the following
screenshot :

Select Product =3

Product:  [FP4030 -

Model:  [FP4D30MR -

Image

Description
HMI

Display : 128 X 64, Graphical display, Multi color backlight
Communication Ports : 2 (1 Serial, 1 USE device)

Keypad : Yes (18 keys)

Touch Screen : No

Expansion Slots Mo

Figure 8: Select Model

Once you select OK, you will see a screen like Figure 9 below that allows you to configure
the name and save directory for your current project.
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Project Configuration @
Froject Information | Alamm | Settings
Project Title : FP4030 [Upto 45 characters)
Save in Directary : C:AProgram Files'\Renu Electronics Pyt LidWFlesiS ofthS anplesFF
Dezcription :
Athor : [Upta 45 characters)
Pazzword [Upto & characters)

Praduct [nformation
Product : FF4030mMB

Model Details
Dizplay : 128 ¥ B4, Graphical dizplay, Multi color backlight
Feypad : Yes (18 keysz)

Communication Porkz -2 (1 Senal. 1 USE device]

COM1 Tes

COM2 Mo

[ ] ][ Cancel ][ Help

Figure 9: Project Configuration

Then you can click OK on the Project Configuration window and you should see a starting
screen similar to Figure 10.
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ﬂ FlexiSofthOffLinet FPA030MRNFP 4030, pzm
Wiew  Mode  Define
O-2EHOBER APEEO XBD e >

B E2EESB s i =R L

Drawing Tools = Quick Buttons = Show Data - Edit Data ~ Advanced Objects » Clock Objects ~

Tools  Help
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d i 14
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Recent Projects L} = | Sereens 1
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BD Project List E Tags 43
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-~ Templates Logic Blocks 1
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{7 Data Windaw
D Kews

D Tasks

D Tags

[-{20 Mebwark Config
{7 Blarms

{1 Languages
{1 TRiPLC Demo.par
] TRIPLC 1.4 - e
{1 TRiTest vs1.4.pzm
{1 TRI Test.pzm

m

|B £ 0 4-0-A-B-2-HHE <

Scratchpad Area ,_

il

[Mode: Offine |

Screen frea  Ci\Program Files\Renu Electronics Put LtdhFlexiSoft\SampleshFP4030.pzm

Figure 10: New Program Window

Next you will want to expand the Network Config menu and right click on the Com!1
folder to add a device as shown in Figure 11. This will open the Com settings window
shown in Figure 12.

Mode Information _
Froject  Wiew  Mode  Define  Tools  Help Made Information |
Mame Node 1 Man15  pddiess 1 [0t 255)
i character
i Interframe Delay (0to3000)ms  FResponseTimeOut 800 (10taG000]ms
Drawving Taols = Quick Buttons = Show Data ~ Edit Data =
Projects Information Retry Court 3 [0ta5) FLC Specific Se_tt_i_r?gs_

Recent Projects

=+ &l Files

=+ Project List
=+ FP4030.pzm

Figure 11: Add PLC to Com1
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The default settings should be configured for TRi 'Super' PLCs already, but if not, you will
need to configure the following as per figure 12 above:

Name: Can be anything

Address: the PLC ID, which is O1 by default.

Port: Com1, which is the only option for this HMI model.

Protocol: Select TriPLC from the dropdown list.

Baud Rate: select 38.4k from the dropdown list.

Data Bits: select 8.

Parity: select None.

Stop Bits: select 1.

Click Add and then Close (everything else can be left as default).

VN OTA~®ND -~

Note: Other seffings such as Response Time Out and Retfry Count can be modified fo
handle com connection issues differently.

Now you can add new screens and configure them with button functions and display
objects as well as general text and pictures.

You can find more information on configuring the program for an FP4030MR with a TRI
PLC as well as information on PLC data mapping between the PLC and HMI in the
"FPA030MR Mapping.pdf” document included in the "FP4030MR Demos and Guides.zip”
package. The Help menu in FlexiSoft also has a lot of information on the available
components that will help to design your touch screen program.
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	6. Open the “TRi PLC Demo.pzm” file from FlexiSoft using Project –> Open and select the file from the C:\TRiLOGI\FlexiSoft for TRi PLCs\Samples folder.  
	7. Transfer the demo program to the HMI using Project –> Transfer –> Download  
	8. Use TRiLOGI to open the FP4030MR.PC6, which is also included in the “FP4030MR Demos and Guides.zip” file, and transfer it to the PLC
	  
	For more detailed instructions, proceed to the subsequent sections of this guide. 
	 
	 
	2. Connect the HMI to a PC 
	 
	Your FP4030MR requires a USB A-B cable (standard PC USB to Square USB) to connect the HMI to your PC (not included), and a custom serial cable with RS232 and RS485 connectors to connect to your TRI PLC (included). 
	 
	It should be connected per the below diagram: 
	 
	   
	 
	  
	3. Connect FP4030MR to PLC 
	 
	The included RS232 to RS485 (2 wire) cable connects between the HMI RS232 port (DB9 connector) and the PLC RS485 port (2 wire), as per the below diagram. Note that the black wire is actually the RS485 + signal and the red wire is actually the RS485 - signal.  
	 
	We recommend crimping plugs onto the red and black RS485 wires on the DB9 cable supplied with the FP4030MR. This will ensure a proper connection when plugged into the PLC RS485 screw terminal. 
	 
	  
	 
	The above drawing can also be referenced in case a custom cable is being built. Note that pins 1 and 4 must be tied together and pins 8 and 9 must be tied together on the HMI COM port when constructing the RS485 cable connection.
	 
	4. Download and Install FlexiSoft for TRi PLCs HMI Software 
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	Figure 1: FlexiSoft Startup Screen
	5. Connect Power to HMI and PLC  
	The FP4030MR has 3 connections for power: +, -, and  . A 24VDC power supply should be used, which can be the same supply used for the PLC.  
	 
	Power should be connected to the FP4030MR as follows : 
	1. Connect the +24VDC terminal from the power supply to the + terminal on the HMI. 
	2. Connect the 0VDC (-) terminal from the power supply to the - terminal on the HMI. 
	3. The   can generally be left unused, but the FlexiPanels user manual should be referenced if you are unsure. 
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	1. Connect the +24VDC terminal from the power supply to the +24V terminal on the PLC. 
	2. Connect the 0VDC (-) terminal from the power supply to the 0V terminal on the PLC. 
	3. Reference the PLC documentation for more information on this. 
	 
	 
	6. Install the FP4030 Device Drivers on the PC 
	 
	The drivers may install automatically, but if not, then you can install the device manually and select the C:\TRiLOGI\FlexiSoft for TRi PLCs\USB Drivers folder to install from. 
	 
	Open "Devices" or "Devices and Printers" from your PC control panel and open the properties for the "Micro PLC" device. 
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	7. Load and Transfer HMI Sample Program 
	 
	The sample program included with this quick start guide is called “TRi PLC Demo.pzm”. You can open this file from FlexiSoft using Project – Open and selecting the file from the C:\TRiLOGI\FlexiSoft for TRi PLCs\Samples folder. 
	 
	This sample program is already pre-configured for communication with a TRI PLC, and it is possible to connect via RS485 or RS232 since both are shared on the HMI COM port and there is no need to specify the specific interface. 
	 
	Once you have opened the sample program, you can transfer it to the HMI as follows : 
	1. Go to the “Project” menu and select “Transfer(Download”. 
	2. A new window should appear as shown in Figure 2. 
	3. Make sure that USB mode is selected at the top-left of the window. 
	4. Make sure the Firmware box is checked. 
	5. Make sure that boxes under Project and Device Settings are all selected as shown in Figure 2. 
	6. Click Download and wait for the message that the download has finished. 
	 
	  
	Figure 2: Download Window
	NOTE: 
	The “Firmware” box typically only needs to be checked the first time a program is being transferred to the HMI or if any COM settings have changed or if there is a firmware update being installed to the HMI.
	 
	8. Load and Transfer PLC Sample Program 
	 
	A Trilogi PLC sample program, called FP4030MR.PC6, is also included in the “FP4030MRdoc.zip” file. This should be opened with Trilogi and transferred as normally done with Trilogi (and TLServer for serial connections). You can find more information on communicating with a PLC using Trilogi from the TL6 Programmers Reference Manual. 
	 
	The FP4030MR.PC6 sample program is only required for the Data Entry function included in screen 11 of the “TRi PLC Demo.pzm” sample program. It could be modified to do more if desired.
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	9. Using the FP4030MR Sample Program 
	 
	Now that the TRi PLC Demo.pzm sample program has been loaded in the HMI, you should see the Home screen for this program : 
	 
	  
	Figure 3: Home Screen 
	 
	You can traverse through the different screens in the sample program by pressing F4 for the next screen or F1 to go backward one page. You can also go back to the home screen (above) by pressing F2. There are 12 screens total, but only screens 2-5 are shown in Figures 4-7 below. 
	 
	  
	Figure 4: I/O Screen
	  
	Figure 5: Analog Screen
	  
	Figure 6: PWM Screen
	  
	Figure 7: LCD Screen
	 
	 
	 
	 
	 
	 
	10. Start a New Program and Configure for a TRI PLC 
	 
	When you start a new program you will be asked to select your HMI model and screen orientation. You should select the FP4030MR (128 x 64) model as per the following screenshot : 
	 
	  
	Figure 8: Select Model 
	 
	Once you select OK, you will see a screen like Figure 9 below that allows you to configure the name and save directory for your current project.  
	 
	  
	Figure 9: Project Configuration 
	 
	Then you can click OK on the Project Configuration window and you should see a starting screen similar to Figure 10. 
	 
	  
	Figure 10: New Program Window 
	 
	Next you will want to expand the Network Config menu and right click on the Com1 folder to add a device as shown in Figure 11. This will open the Com settings window shown in Figure 12. 
	 
	  
	Figure 11: Add PLC to Com1 
	  
	Figure 12: Configure HMI Com Settings to Match PLC
	 
	              
	                
	The default settings should be configured for TRi 'Super' PLCs already, but if not, you will need to configure the following as per figure 12 above: 
	 
	1. Name: Can be anything 
	2. Address: the PLC ID, which is 01 by default. 
	3. Port: Com1, which is the only option for this HMI model. 
	4. Protocol: Select TriPLC from the dropdown list. 
	5. Baud Rate: select 38.4k from the dropdown list. 
	6. Data Bits: select 8. 
	7. Parity: select None. 
	8. Stop Bits: select 1. 
	9. Click Add and then Close (everything else can be left as default).  
	Note: Other settings such as Response Time Out and Retry Count can be modified to handle com connection issues differently. 
	 
	Now you can add new screens and configure them with button functions and display objects as well as general text and pictures.  
	 
	You can find more information on configuring the program for an FP4030MR with a TRI PLC as well as information on PLC data mapping between the PLC and HMI in the “FP4030MR Mapping.pdf” document included in the “FP4030MR Demos and Guides.zip” package. The Help menu in FlexiSoft also has a lot of information on the available components that will help to design your touch screen program. 

